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Аннотация дисциплины 

«Цифровая электроника» 
 

Учебная дисциплина «Цифровая электроника» предназначена для 

магистрантов 1 курса магистратуры 11.04.04 Электроника и наноэлектроника, 

магистерской программы «Электроника и наноэлектроника (совместно с ИАПУ 

ДВО РАН)». 

Дисциплина «Цифровая электроника» входит в часть формируемую 

участниками образовательных отношений цикла дисциплин образовательной 

программы, и является факультативной дисциплиной (ФТД.В.01), реализуется на 

1 курсе, в 2 семестре, завершается зачтом. Общая трудоемкость освоения 

дисциплины составляет 2 З.Е. (72 часа).  Учебным планом предусмотрены 

лекционные занятия (18 час.), практические занятия (18 час.), самостоятельная 

работа студента (36 час.), зачет.  

Язык реализации – русский. 
Цель изучения дисциплины - ознакомление с особенностями современных 

принципов построения цифровой электроники и типами возможных архитектур. 

Задачи: 

−  изучение принципов построения и проектирования приборов цифровой 

электроники; 

−  освоение методов диагностики в наноэлектроники используя цифровые 

приборы и системы; 

−  установление взаимосвязи между структурными свойствами материалов и 

их магнитными характеристиками и проводимостью пи помощью средств 

цифровой электроники. 

В результате изучения данной дисциплины у обучающихся формируются 

следующие профессиональные компетенции: 
Тип задач Код и наименование 

профессиональной компетенции 
(результат освоения) 

Код и наименование индикатора достижения 
компетенции 

Производственно- ПК-12 Способен осуществлять 
авторское сопровождение 

ПК-12.1 осуществляет авторское сопровождение 
разрабатываемых систем электронной техники 



технологический разрабатываемых устройств, 
приборов и системы электронной 
техники на этапах проектирования 
и производства 
 

ПК-12.2 применяет принципы авторского 
сопровождения разрабатываемых систем 
электронной техники 

Научно-
педагогический 

ПК-13 Способен проводить 
лабораторные и практические 
занятия со студентами, 
руководить курсовым 
проектированием и выполнением 
выпускных квалификационных 
работ бакалавров 

ПК-13.1 использует современные 
образовательные технологии в учебном процессе 

ПК-13.2 проводит учебные и консультативные 
занятия со студентами 

 
Код и наименование индикатора 

достижения компетенции 
Наименование показателя оценивания 
(результата обучения по дисциплине) 

ПК-12.1 осуществляет авторское 
сопровождение разрабатываемых систем 
электронной техники 

Знает нормативную документацию и требования к осуществлению 
авторского сопровождения разрабатываемых систем электронной 
техники 
Умеет осуществлять авторское сопровождение разрабатываемых 
систем электронной техники на этапах проектирования и 
производства 
Владеет навыками сопровождения разрабатываемых систем 
электронной техники на основе своего авторства 

ПК-12.2 применяет принципы 
авторского сопровождения 
разрабатываемых систем электронной 
техники 

Знает принципы авторского сопровождения разрабатываемых систем 
электронной техники 
Умеет применять принципы авторского сопровождения 
разрабатываемых устройств, приборов и систем электронной техники 
Владеет навыками осуществления авторского сопровождения 
разрабатываемых устройств, приборов и систем электронной техники 

ПК-13.1 использует современные 
образовательные технологии в учебном 
процессе 

Знает современные образовательные технологии  
Умеет выделить наиболее подходящую образовательную технологию 
в соответствии со своей научно-педагогической задачей 
Владеет педагогическими навыками, отвечающими современным 
требованиям учебного процесса 

ПК-13.2 проводит учебные и 
консультативные занятия со студентами 

Знает основы коммуникаций со студентами в учебной и 
консультативной деятельности, требования к курсовому 
проектированию и выполнению выпускных квалификационных работ 
бакалавров 
Умеет проводить лабораторные, практические и консультативные 
занятия со студентами, осуществлять руководство курсовыми и 
выпускными квалификационными работами бакалавров 
Владеет методами и приемами проведения учебных и 
консультативных занятий со студентами, навыками руководства 
курсовыми и выпускными квалификационными работами бакалавров  

 

 

I. СТРУКТУРА И СОДЕРЖАНИЕ ТЕОРЕТИЧЕСКОЙ ЧАСТИ КУРСА 

Лекционные занятия (10 часов, в том числе с использованием МАО – 10 

часов) 

Тема 1. Digital electronics in industrial automation systems / Цифровая 



электроника в системах промышленной автоматизации (2 час., МАО - 2 час.) 

Цифровая электроника как инструмент для промышленной автоматизации 

• Актуальность курса; 

• Промышленная электроника — фундамент автоматизации и роботизации; 

• История и вехи развития; 

• Специфика отрасли; 

• Системный подход к изучению курса; 

• Структуры схемотехнических и аппаратно-программных решений; 

• Тенденции развития промышленной электроники и систем автоматизации; 

• Архитектура систем промышленной автоматизации; 

• Понятие автоматизированной системы управления технологическим 

процессом (АСУ ТП); 

• Интегрированная информационно-управляющая система предприятия; 

• Подсистемы АСУ и уровни управления; 

• Требования к архитектуре; 

• Построение архитектуры; 

• Распределенные системы автоматизации; 

• Разработка, проектирование и внедрение системы автоматизации. 

Тема 2. Sensors and measuring devices / Датчики и измерительные устройства 

(2 час., МАО - 2 час.) 

• Датчики устройств дискретной автоматики: индуктивные датчики 

приближения, емкостные датчики приближения, механические конечные 

выключатели, фотоэлектрические датчики; 

• Датчики устройств управления непрерывными процессами: тока, скорости и 

положения, ускорения, момента, давления, температуры; 

• Датчики магнитного поля: магниторезистивные датчики, датчики Холла и 

датчики Виганда. 

Тема 3. Subsystems for the collection and processing of information / Подсистемы 

сбора и обработки информации (2 час., МАО - 2 час.) 



• Основные параметры измерительной системы; 

• Структура системы сбора данных. Обработка сигналов: аналоговый сигнал, 

цифровой сигнал, цифро-аналоговое преобразование; 

• Основные компоненты одного измерительного канала; 

• Датчики. Основные виды измеряемых величин, стандартные аналоговые и 

цифровые сигналы; 

• Обзор аппаратных измерительных средств; 

• Обзор программных средств для систем сбора и обработки информации; 

• Возможности пакета LabVIEW; 

• Основы работы с Arduino. Разработка электронных устройств в 

программной оболочке Arduino IDE; 

Тема 4. Actuators / Исполнительные устройства (2 час., МАО - 2 час.) 

• Классификация исполнительных устройств, основные понятия и 

определения; 

• Пневматические и гидравлические исполнительные устройства; 

• Электрические исполнительные устройства. 

Тема 5. Logic Elements of Логические элементы цифровой электроники (2 час., 

МАО - 2 час.) 

• Дополнительные логические операции, используемые в цифровой 

электронике: отрицание конъюнкции (штрих Шеффера), отрицание 

дизъюнкции (стрелка Пирса), исключающее или (либо). Таблицы 

истинности. 

• Базовые логические элементы цифровой электроники: конъюнктор, 

дизъюнктор, инвертор, элемент Шеффера, элемент Пирса, сумматор по 

модулю 

• Общий принцип обозначения логических элементов. 

• Функционально полные системы логических элементов: булевский базис, 

базис Шеффера, базис Пирса. Реализация полного набора базовых 

логических элементов с помощью каждого из трех базисов. 



  



II. СТРУКТУРА И СОДЕРЖАНИЕ ПРАКТИЧЕСКОЙ ЧАСТИ КУРСА 

Практические занятия (26 часов, в том числе с использованием МАО – 

26 часов) 

ТЕМА 1. Frequency analysis / Частотный анализ (2 часа, МАО – 2 часа).  

Цель: открыть и запустить прибор. 

1. Запустите LabVIEW (Пуск→Все программы→ National 

Instruments LabVIEW 8.0). Появится диалоговое окно Getting Started. 

2. Выберете Find Examples. На экране появиться диалоговое окно 

поиска примеров ВП (рис. 1.1), разбитых по категориям. 

3. Перейдите на закладку Browse (Обзор). Отметьте пункт Directory 

Structure. В списке примеров выберете папку Apps, в которой откройте 

библиотеку Fereqresp.lib и дважды щелкните на Frequency Response VI. 

Появится лицевая панель ВП Частотный анализ. 

4. На инструментальной панели нажмите кнопку Run. Данный 

ВП моделирует посылку сигнала к измерительному прибору и 

регистрацию его отклика. Реакцию прибора в частотной области можно 

будет увидеть на графике лицевой панели. 

5. С помощью инструмента УПРАВЛЕНИЕ измените значение 

уставки амплитуды Amplitude. Изменить значение можно, либо 

переместив указатель кнопки в нужное положение, либо используя стрелки 

изменения значений элемента управления, либо введя число 

непосредственно в дисплей элемента. 

Если число введено непосредственно в дисплей элемента, то 

необходимо нажать кнопку Enter, появившуюся на инструментальной 

панели. Иначе число не будет введено. 

6. Нажать кнопку Run и запустить ВП. Изменяя значения других 

средств управления, находящихся на панели, исследовать работу ВП. 

Блок-диаграмма 

7. Перейдите на блок-диаграмму. Для этого выберите в главном 

меню Window→ ShowDiagram или введите <Ctrl-E> с клавиатуры. 



Блок-диаграмма содержит несколько основных объектов, 

включая подпрограммы ВП, функции и структуры. 

8. С помощью инструмента УПРАВЛЕНИЕ дважды щелкните по 

иконке DMM. 

Эта иконка – графическое представление подпрограммы DemoFluke 

8840A VI. После двойного щелчка откроется подпрограмма и на экране 

появится её лицевая панель. Дизайн лицевой панели напоминает мультиметр. Вот 

почему программы LabVIEW называются виртуальными приборами. 

Создавая модульные приложения LabVIEW, можно изменять только 

части приложения и/или многократно использовать эти части в других 

приложениях. Например, эта подпрограмма моделирует действие 

комбинированного прибора DemoFluke, но пользователь может внести в 

него изменения, чтобы получить новые функции. 

9. Выберите в главном меню пункты File→Close и закройте Demo 

Fluke8840AVI. 

10. Закройте ВП Frequency Response VI. 

 
ТЕМА 2. Creating LabVIEW routines / Создание подпрограмм LabVIEW (4 

часа, МАО – 4 часа). 

Цель: Создать иконку и настроить соединительную панель для 

возможности использования ВП в качестве подпрограммы ВП. 

В этом уроке представлена последовательность действий по 

созданию иконки и настройке соединительной панели для созданного ВП, 

который переводит значение измеренной температуры из °С в °F. 

Лицевая панель 

1. Выберите пункт главного меню File»Open, укажите папку 

d:\student\фамилия\ и выберите файл Преобразование С в F (начало).vi 

Если закрыты все ВП, следует нажать кнопку OpenVI (Открыть ВП) 

в диалоговом окне LabVIEW. 

2. Щелкните правой кнопкой мыши по иконке ВП и в контекстном 



меню выберите пункт Edit Icon (Редактирование иконки). Появится 

диалоговое окно редактора иконки IconEditor. 

3. Дважды щелкните правой кнопкой мыши по инструменту ВЫБОР. 

4. Нажав кнопку <Delete> очистите область редактирования иконки. 

5. Дважды щелкните по инструменту ПРЯМОУГОЛЬНИК (показан 

слева), чтобы обвести область редактирования границей выбранного 

цвета. 

6. Создайте следующую иконку: 

a.Введите текст инструментом ВВОД ТЕКСТА, который показан 

слева. 

b.Напечатайте «С» и «F» 

c. Для выбора размера шрифта дважды щелкните левой кнопкой 

мыши по инструменту ВВОД ТЕКСТА. 

d. Чтобы нарисовать стрелку, воспользуйтесь инструментом 

КАРАНДАШ. 

e. Для передвижения текста и стрелки по полю редактирования 

иконки используйте инструмент ВЫБОР и стрелки на клавиатуре. 

f. В разделе Copy from (Копировать) выберите В & W (черно-белую) 

иконку и 256 Colors (256-цветный режим) для создания черно-белой иконки, 

которую LabVIEW использует в случае отсутствия цветного принтера. 

g. В разделе Copy from (Копировать) выберите 16 Colors и 256 

Colors. 

h. После завершения редактирования иконки нажмите кнопку ОК и 

закройте Icon Editor. Новая иконка появится в правом верхнем углу обеих 

панелей. 

7. Перейдите на лицевую панель, щелкните правой кнопкой мыши на 

иконке и выберите пункт Show Connector (Показать поля 

ввода/вывода данных) из контекстного меню. Количество 

отображаемых LabVIEW полей ввода/вывода данных соответствует 

количеству элементов на лицевой панели. Например, лицевая панель 



этого ВП имеет два элемента ГрадС и ГрадF и LabVIEW выводит в 

соединительной панели два поля, показанные слева. 

8. Элементам управления и отображения данных назначьте 

соответственно поля ввода и вывода данных. 

а. В пункте главного меню Help (Помощь) выберите ShowContext 

Help (контекстную подсказку) и выведите на экран окно Context Help 

(контекстной справки) для просмотра соединений. 

b. Щелкните левой кнопкой мышки на левом поле соединительной 

панели. Инструмент УПРАВЛЕНИЕ автоматически поменяется на 

инструмент СОЕДИНЕНИЕ, а выбранное поле окрасится в черный цвет. 

c. Щелкните левой кнопкой мыши по элементу Град С. Левое поле 

станет оранжевым и выделится маркером. 

d. Щелкните курсором по свободному пространству. Маркер исчезнет, и 

поле окрасится в цвет данных типа соответствующего элемента управления. 

e. Щелкните левой кнопкой мыши по правому полю соединительной 

панели и элементу Град F. Правое поле станет оранжевым. 

f.Щелкните курсором по свободному пространству. Оба поля 

останутся оранжевыми. 

g. Наведите курсор на область полей ввода/вывода данных. Окно 

ContextHelp (контекстной справки) покажет, что оба поля соответствуют 

типу данных двойной точности с плавающей запятой. 

9. Выберите пункт главного меню File»Save. Сохраните ВП под 

именем Преобразование С в F.vi, он будет использоваться позднее. 

10. Выберите пункт главного меню File»Close. Закройте ВП. 

 

ТЕМА 3. Multiple Repetitions and Loops / Многократные повторения и циклы 

(4 часа, МАО – 4 часа). 

Цель: использование терминала выходных данных цикла While. 

Создайте ВП, который генерирует случайные числа до тех пор, пока 

одно из них не окажется равным значению, введенному в элемент 



управления. При этом должно отображаться количество итераций, 

выполненное циклом. 

Лицевая панель 

1. Откройте новую лицевую панель. Создайте лицевую панель, 

разместив на ней элементы управления и отображения. 

a. Поместите на лицевую панель числовой элемент управления, 

находящийся на палитре Controls»Numeric. Назовите элемент 

Заданное число для сравнения. Этот элемент задает число, с 

которым будет проводиться сравнение. 

b. Поместите на лицевую панель числовой элемент отображения, 

находящийся на палитре Controls»Numeric. Назовите элемент 

Текущее случайное число. Этот элемент отображает текущее 

значение, выданное функцией Генератор случайных чисел. 

c. Поместите еще один числовой элемент отображения на лицевую 

панель. Назовите элемент Кол-во итераций. Этот элемент 

показывает номер текущей итерации. 

Установка диапазона данных 

Чтобы значения элемента Заданное число для сравнения не 

выходили за рамки диапазона значений, выдаваемых функцией Генератор 

случайных чисел, следует использовать диалоговое окно Data Range. 

Выполните следующие шаги для настройки диапазона выходных значений 

элемента Заданное число для сравнения от 0 до 100000 с шагом 

изменения 1 и значением по умолчанию равным 50. 

2. Щелкните правой кнопкой мыши по элементу Заданное число 

для сравнения. Из контекстного меню выберите пункт Data Range. 

Появится диалоговое окно, показанное ниже. 

3. Снимите выделение с пункта UseDefaults (использовать значения 

по умолчанию). 

4. Выберите пункты, показанные в этом примере диалогового окна. 

a. Установите DefaultValue(значение по умолчанию) равным 50. 



b. Установите Minimum Value (минимальное значение) равным 0 и 

выберите Coerce. 

c. Установите Maximum Value (максимальное значение) равным 

10000 и выберите Coerce. 

d. Установите Increment (значение приращения) равным 1 и 

выберите Coerce to Nearest. 

5. Выберите раздел Format and Precision(формат и точность). 

 

Установка количества знаков после запятой 

По умолчанию, LabVIEW отображает числовые элементы 

управления и отображения в виде десятичных чисел с точностью до двух 

знаков после запятой (3,14). С помощью опции Format&Precision можно 

изменить точность и вид представления значений элементов (научная 

нотация, инженерная нотация, формат времени). 

6. Щелкните правой кнопкой мыши по элементу Текущееслучайное 

числои выберите в контекстном меню пункт Format&Precision. Появится 

следующее диалоговое окно Format&Precision. 

7.Сделайте настройки, показанные ниже. В поле ввода Digits of Precision следует 

ввести значение 0. 

8. Повторите шаги 6 и 7 для элементов отображения Текущее 

случайное число и Кол-во итераций. 

Блок-диаграмма 

9. Создайте блок-диаграмму 

 Поместите на блок-диаграмму функцию Random Number 

(Генератор случайных чисел), расположенную на палитре Функций 

в разделе Function» Programming»Numeric. Эта функция 

генерирует случайные числа в пределах от 0 до 1 

Поместите на блок-диаграмму функцию Multiply (Умножение), 

расположенную в палитре Функций в разделе Function» 

Programming»Numeric. Эта функция умножает текущее значение с 



выхода функции Random Number(Генератор случайных чисел) на 

10000. 

Создайте константу. Для этого следует навести курсор на поле ввода 

данных функции Multiply (Умножение), щелкнуть по нему правой 

кнопкой мыши и выбрать в контекстном меню пункт Create»Constant 

С помощью инструмента ВВОД ТЕКСТА присвойте ей значение 

10000. 

Поместите на блок-диаграмму функцию Round To Nearest 

(Округление до ближайшего целого), расположенную в палитре 

Функций в разделе Function»Numeric. Эта функция будет округлять 

полученное в пределах от 0 до 10000 случайное число до ближайшего 

целого числа. 

Поместите на блок-диаграмму функцию Not Equal? (≠), 

расположенную в палитре Функций в разделе Function» 

Programming»Comparison. Эта функция предназначена для 

сравнения случайного числа с числом, введенным в элемент 

управления Заданное число для сравнения. Если значения не равны, 

функция выдает значение TRUE. 

Поместите на блок-диаграмму цикл While, расположенный в палитре 

Функций в разделе Function»Programming»Structures. Наведите 

курсор на терминал условия выхода, щелкните по нему правой 

кнопкой мыши и выберите пункт Continue if True (Продолжение 

если Истина). 

Подсоедините терминал счетчика итераций к границе области цикла 

While. На границе цикла появится синий прямоугольник. Терминал 

выходных данных цикла присоединен к функции приращения. При 

выполнении цикла счетчик итераций получает приращение равное 1. 

После завершения цикла значение счетчика итераций передается на 

выход через терминал выхода цикла. Вне тела цикла значение счетчика 

итераций увеличивается на единицу для отображения количества 



выполненных итераций. 

Поместите на блок-диаграмму функцию Increment (Приращение на 1), 

расположенную в палитре Функций в разделе Function» 

Programming»Numeric. Эта функция добавляет 1 к значению 

счетчика итераций после завершения выполнения цикла. Следует 

обратить внимание, что на терминале элемента Кол-во итераций 

имеется серая точка, означающая, что LabVIEW автоматически 

осуществляет преобразование типа данных счетчика итераций к типу 

данных терминала элемента Кол-во итераций. Подробнее о 

приведении типов данных можно прочитать в разделе В "Цикл For (с 

фиксированным числом итераций)". 

10. Сохраните ВП под именем Подсчет итераций.vi. 

Запуск ВП 

11. Перейдите на лицевую панель и измените значение элемента 

Заданное число для сравнения. 

12. Запустите ВП. Измените значение элемента Заданное число для 

сравнения и запустите ВП снова. При этом элемент Текущее 

случайное число обновляется после каждой итерации цикла, 

потому что его терминал данных расположен внутри тела цикла. 

Значение же элемента Кол-во итераций обновляется после 

завершения цикла, потому что терминал данных этого элемента 

расположен вне тела цикла. 

13. Чтобы посмотреть, как ВП обновляет значения элементов 

отображения информации, необходимо запустить ВП в режиме 

анимации. Для этого следует нажать на инструментальной панели 

кнопку Highlight Execution, показанную слева. Режим отладки 

анимирует поток данных, проходящих по блок-диаграмме. Таким 

образом, имеется возможность наблюдать изменения значений на 

каждом этапе их генерации. 

 14. Измените значение элемента Заданное число для сравнения таким 



образом, чтобы оно с увеличением на 1 выходило за 

установленный диапазон значений от 0 до 10000. 

15. Запустите ВП. Lab VIEW автоматически приведет новое значение 

к ближайшему значению в указанном диапазоне входных данных 

элемента. 

16. Закройте ВП. 

ТЕМА 4. Processing of data arrays / Работа с массивами данных  (4 часа, МАО 

– 4 часа). 

Цель: создание массивов и знакомство с функциями обработки 

массивов. 

Выполните следующие шаги для создания ВП, который формирует 

массив случайных чисел, масштабирует полученный массив и выделяет из 

него подмножество. 

Лицевая панель 

1. Откройте новый ВП и создайте лицевую панель, как показано 

ниже. 

a. В палитре Controls»Modern»Array, Matrix& Cluster выберите 

шаблон массива. 

b. Созданному массиву присвойте имя Массив случайных чисел. 

c. Поместите внутрь шаблона массива цифровой элемент 

отображения, расположенный в палитре Controls»Numeric. 

d. С помощью инструмента ПЕРЕМЕЩЕНИЕ измените размер 

массива таким образом, чтобы он содержал 10 элементов. 

e. Нажмите и удерживайте клавишу <Ctrl> и, перемещая элемент 

Массив случайных чисел, создать две его копии. 

f. Копиям присвойте имена Конечный Массив и Подмножество 

Массива. 

g. Создайте три цифровых элемента управления и присвойте им 

имена Масштабный коэффициент, Старт подмножества и 

Количество элементов подмножества.  



h. Щелкните правой кнопкой мыши по элементам Старт 

подмножества и Количество элементов подмножества, в 

контекстном меню выберите пункт Representation, затем пункт 

I32. 

Блок-диаграмма 

2. Постройте блок-диаграмму, как показано ниже. 

Выберите функцию Random Number (0-1), расположенную в 

палитре Functions»Programming»Numeric. Эта функция будет 

генерировать случайное число в пределах от 0 до 1. 

Выберите цикл For, расположенный в палитре Functions» 

Programming»Structures. Этот цикл на терминале выхода 

накапливает массив из 10 случайных чисел. Терминалу количества 

итераций присвойте значение 10. 

Выберите функцию Array Subset, расположенную в палитре 

Functions»Programming»Array. Эта функция выдает подмножество 

массива, начиная со значения, введенного в элементе Старт 

подмножестваи будет содержать количество элементов, указанное в 

элементе Количество элементов подмножества. 

3. Сохраните ВП под именем Работа с массивами.vi 

ЗапускВП 

4. Перейдите на лицевую панель, измените значения элементов 

управления и запустите ВП. 

Цикл For совершит 10 итераций. Каждая итерация создаст 

случайное число и сохранит его в терминале выхода из цикла. В элементе 

Массив случайныхчисел отобразится массив из 10 случайных чисел. ВП 

умножит каждое значение этого массива на число, введенное в элемент 

управления Масштабный коэффициент, для создания массива, 

отображаемого в индикаторе Конечный массив. ВП выделит 

подмножество из получившегося массива, начиная со значения в элементе 

Старт подмножества, длиной, указанной в элементе Количество 



элементов подмножества, и отобразит это подмножество в индикаторе 

Подмножество массива. 

5. Закройте ВП. 

 

ТЕМА 5. Work with clusters / Работа с кластерами (4 часа, МАО – 4 часа). 

Цель: Создание кластеров на лицевой панели. Используя функции 

обработки кластеров, собирать и демонтировать кластеры 

Лицевая панель 

1. Откройте новый ВП и создайте лицевую панель, как показано 

ниже. 

a. Поместите на лицевую панель кнопку «Стоп» и круглый 

светодиод. 

b. Из палитры Controls»Modern»Array, Matrix& Clusterвыберите 

шаблон кластера. 

c. Объекты лицевой панели, показанные на иллюстрации, поместите 

в шаблон кластера. 

d. Создайте и переименуйте копию элемента Кластер в 

Модифицированный Кластер. После этого щелкните правой 

кнопкой мыши по границе шаблона кластера 

Модифицированный Кластер и выберите из контекстного меню 

пункт ChangetoIndicator. 

e. Повторите пункт d для создания элемента Маленький кластер. 

Измените его, как показано на рисунке. 

2. Проверьте порядковые номера элементов в кластерах Кластер и 

Маленький кластер. Порядковые номера элементов кластера 

Модифицированный кластер и Кластер должны совпадать. 

а. Щелкните правой кнопкой мыши по границе шаблона каждого 

кластера, из контекстного меню выберите пункт Reorder 

ControlsinCluster. 

b. Установите Порядковые номера элементов 



 Блок-диаграмма 

3. Создайте блок-диаграмму, как показано на рис. 6.3. 

Из палитры Functions»Programming»Cluster выберите функцию 

Unbundle. Эта функция разъединяет кластер. Измените размер этой 

функции до четырех полей ввода данных или соедините терминал 

данных кластера с функцией для автоматического добавления полей 

ввода данных. 

Из палитры Functions» Programming»Cluster выберите функцию 

Bundle. Эта функция объединит элементы в кластер Маленький 

кластер. 

Из палитры Functions»Programming»Cluster выберите функцию 

Unbundle by Name. Эта функция выделит два элемента из кластера 

Кластер. Измените размер функции до двух полей вывода данных. 

Если имена в полях вывода данных отличаются от показанных на 

иллюстрации, следует щелкнуть правой кнопкой мыши по имени 

элемента и в контекстном меню войти в раздел SelectItem. 

Из палитры Functions»Programming»Numeric выберите функцию 

Increment. Эта функция добавит 1 к значению элемента Число. 

Из палитры Functions»Programming»Boolean выберите функцию 

Not. Эта функция выдаст логическое отрицание элемента 

Логический1. 

Из палитры Functions»Programming»Cluster выберите функцию 

BundlebyName. Эта функция изменит значения элементов Числои 

Логический в кластере Кластер и создаст кластер 

Модифицированный кластер. Измените размер этой функции на 

два поля ввода данных. Если имена в полях вывода данных 

отличаются от показанных на иллюстрации, следует щелкнуть 

правой кнопкой мыши по имени элемента и в контекстном меню 

войти в раздел Select Item. 

4. Сохраните ВП под именем Работа с кластерами, vi 



5. Перейдите на лицевую панель и запустите ВП. 

6. Поменяйте значения элементов в кластере Кластер и запустите ВП. 

 

ТЕМА 6. Temperature monitoring / Мониторинг температуры (4 часа, МАО – 
4 часа). 
Цель: приобретение навыков по использованию графика Диаграмм 

для получения и отображения данных. 

Лицевая панель 

1. Откройте новый ВП и создайте лицевую панель 

1.1 Выберите график Диаграмм (Waveform Chart) из палитры 

Controls»Modern»Graphи поместите его на лицевую панель. 

1.2. Щелкните правой кнопкой мыши на графике Диаграмм и 

настройте параметры в соответствии с рис. 7.2 и 7.3. 

1.3 Поместите на лицевую панель ВП кнопку «СТОП», 

останавливающую выполнения измерений; числовой индикатор для 

отображения температуры в данный момент времени и индикатор в виде 

градусника. 

1.4 Переименуйте оси графика на «Время» (ось Х) и «Температура» 

(Ось Y). 

1.5 Измените диапазон отображаемых значений оси температуры на 

0–30 0С. 

Блок-диаграмма 

2 Перейдите на блок-диаграмму, выбрав пункт главного меню 

Window»ShowDiagram и создайте блок-схему, изображённую на рис. 7.8.  

2.1 Поместите на бланк блок-диаграммы компонент DAQ Assistant. 

Он находится в палитре MeasurementI/O» DAQmx– DataAcquisition. 

2.2 После помещения компонента появится окно выбора задачи DAQ 

Assistant (рис. 7.5).В появившемся окне раскройте список задач аналогового ввода 

(Analog 

Input) и выберите задачу измерения напряжения (Voltage). Нажмите кнопку Next. 

2.3 Новое открывшиеся окно (рис. 7.6) позволяет выбрать канал 



измерения. Выберите из списка ai0 и нажмите кнопку Finish. 

2.4 Далее открывается окно настройки параметров измерения (рис. 7.7). 

Задайте параметры как показано на рис. 7.7. 

На вкладке Settings: 

• диапазон измеряемого напряжения (SignalInputRange) от 0 В 

(Min) до 10 В (Max); 

• конфигурация входных терминалов (Terminal Configuration) – 

измерение с общимзаземлённымпроводом(RSE).На вкладке Task 

Timingвыберите способ измерения однавыборка 

позапросу(1 Sample(OnDemand)). Нажмите кнопку Ok. Настройка параметров 

измерения закончена. 

2.5 Поместите на блок-диаграмму элементы, численно 

преобразующие измеренное напряжение в температуру по формуле. 

2.6 Дополнительно разместите числовой индикатор и индикатор в 

виде термометра. Соедините параллельно с Waveform Chart. 

2.7 Для задания интервала измерения поместите ВП WaiteUntilNext 

ms Multiple из палитры Time & Dialog. Создайте константу с значением 

1000 мс и соедините со входом ВП. 

2.8 Сохраните прибор с именем Измерение температуры.vi. 

2.9 Запустите прибор и наблюдайте за изменением графика, нагревая 

датчик температуры пальцами рук. 

2.10 Ознакомьтесь с другими настройками Waveform Chart. 

 

ТЕМА 7. Writing data table / Запись таблицы данных (4 часа, МАО – 4 час). 

Цель: Сохранить 2D массив в текстовый файл в виде таблицы так, чтобы он был 

доступен редактору электронной таблицы. В упражнении 9-4 строка была 

отформатирована таким образом, что позиция табулятора разделял столбцы, а 

символ конца строки разделял строки. Выполните следующие шаги для изучения 

ВП, который сохраняет числовой массив в файл в формате, доступном для 

редактора электронных таблиц. 



Лицевая панель 

1. Создайте лицевую панель ВП. 

Блок-диаграмма 

2. Создайте блок-диаграмму: 

• ВП Sine Pattern VI, расположенный в палитре 

Functions»Signal Processing»Signal Generation выдает числовой 

массив из 128 элементов, содержащий значения синусоидального 

сигнала. Константа 90,0 определяет фазу гармонического сигнала. 

• ВП Uniform White Noise VI, расположенный в палитре 

Functions»Signal Proсessing»Signal Generation выдает числовой 

массив из 128 элементов, содержащий значения шумового 

сигнала. 

•  Функция  Build 
Array,  

расположенная 
в  палитре 

Functions»Programming»Array, 
компонует 2D массив из 
массивов 

    

синуса, шума и косинуса.     

Массивсинуса  
Массившума  
Массивкосинуса  

… 
… 
… 

   

• Функция Transpose 2D Array, расположенная в палитре 

Functions»Programming»Array, перестраивает элементы 2D 

массива так, что элемент [i,j] становится элементом [j,i]. 

• ВП Write To Spreadsheet File VI, расположенный в палитре 

Functions» Programming»File I/O, форматирует 2D массив в 

строку таблицы символов и записывает строку в файл. Формат 

строки показан на рисунке, где стрелка → показывает позицию 

табулятора, а символ параграфа ¶ показывает окончание строки 

символов. 

• Функция NumberToFractionalString, расположенная впалитре 

Funсtions»Programming»String»String/Number Conversion, 

преобразуетмассив чисел в массив строк, которые отображаются в 



таблице. 

ЗапускВП 

3. Запустите ВП. ВП генерирует 2D массив из 128 строк и 3 

столбцов. Первый столбец содержит данные осциллограммы синуса, 

второй – осциллограммы шума, третий столбец – данные осциллограммы 

косинуса. ВП выводит осциллограммы каждого столбца и отображает 

данные в виде таблицы. После вывода данных на экран появляется 

диалоговое окно. 

4. Введите имя файла осциллограмма.vi и нажмите на кнопку Save 

или ОК. Позднее этот файл будет использоваться. 

5. Закройте ВП. 

Примечание В этом примере сохраняются в файл только три 

массива. Для добавления большего количества массивов следует 

увеличить количество полей ввода данных функции BuildArray. 

Дополнительная часть 

Откройте файл текстовым редактором или редактором электронных 

таблиц и просмотрите его содержимое. 

6. Откройте текстовый редактор. 

7. Откройте файл осциллограммам. Данные синуса представлены в 

первом столбце, шум – во втором, косинус – в третьем. 

8. Выйдите из текстового редактора или редактора электронных 

таблиц и вернитесь в LabVIEW. 

 
III. УЧЕБНО-МЕТОДИЧЕСКОЕ ОБЕСПЕЧЕНИЕ 

САМОСТОЯТЕЛЬНОЙ РАБОТЫ БУЧАЮЩИХСЯ 
 

Учебно-методическое обеспечение самостоятельной работы обучающихся по 

дисциплине «Цифровая электроника» представлено в Приложении 1 и включает в 

себя: 

- план-график выполнения самостоятельной работы по дисциплине, в том 

числе примерные нормы времени на выполнение по каждому заданию; 



- характеристика заданий для самостоятельной работы обучающихся и 

методические рекомендации по их выполнению; 

- требования к представлению и оформлению результатов самостоятельной 

работы; 

- критерии оценки выполнения самостоятельной работы. 

Трудоемкость дисциплины составляет 108 часов, из них 36 аудиторной работы. 

IV. КОНТРОЛЬ ДОСТИЖЕНИЯ ЦЕЛЕЙ КУРСА 
№ 
п/п 

Контролируемые 
разделы / темы 

дисциплины 

Коды и этапы 
формирования 
компетенций 

Оценочные средства 
текущий контроль промежуточн

ая аттестация 
1 Частотный анализ ПК-12, 

ПК-13 
знает  Практическая 

работа 
зачет, 
вопросы 1-7 

умеет Практическая 
работа 

зачет, 
задание, 
тип 1 

владеет Практическая 
работа 

зачет, 
задание, 
тип 1 

2 Создание подпрограмм 
LabVIEW 

ПК-12, 
ПК-13 

знает  Практическая 
работа 

зачет, 
вопросы 8-11 

умеет Практическая 
работа 

зачет, 
задание, 
тип 2 

владеет Практическая 
работа 

зачет, 
задание, 
тип 2 

3 Многократные 
повторения и циклы 

ПК-12, 
ПК-13 

знает  Практическая 
работа 

зачет, 
вопросы 12-13 

умеет Практическая 
работа 

зачет, 
задание, 
тип 3 

владеет Практическая 
работа 

зачет, 
задание, 
тип 3 

4 Работа с массивами 
данных 

ПК-12, 
ПК-13 

знает  Практическая 
работа 

зачет, 
вопросы 14-15 

умеет Практическая 
работа 

зачет, 
задание, 
тип 4 

владеет Практическая 
работа 

зачет, 
задание, 
тип 4 

5 Работа с кластерами ПК-12, 
ПК-13 

знает  Практическая 
работа 

зачет, 
вопросы 16-17 



умеет Практическая 
работа 

зачет, 
задание, 
тип 5 

владеет Практическая 
работа 

зачет, 
задание, 
тип 5 

6 Мониторинг 
температуры 

ПК-12, 
ПК-13 

знает  Практическая 
работа 

зачет, 
вопросы 18-19 

умеет Практическая 
работа 

зачет, 
задание, 
тип 6 

владеет Практическая 
работа 

зачет, 
задание, 
тип 6 

7 Запись таблицы данных ПК-12, 
ПК-13 

знает  Практическая 
работа 

зачет, 
вопросы 20-21 

умеет Практическая 
работа 

зачет, 
задание, 
тип 7 

владеет Практическая 
работа 

зачет, 
задание, 
тип 7 

Типовые контрольные задания, методические материалы, определяющие 

процедуры оценивания знаний, умений и навыков и (или) опыта деятельности, а 

также критерии и показатели, необходимые для оценки знаний, умений, навыков 

и характеризующие этапы формирования компетенций в процессе освоения 

образовательной программы, представлены в Приложении 2. 

 

V. СПИСОК УЧЕБНОЙ ЛИТЕРАТУРЫ И ИНФОРМАЦИОННО-
МЕТОДИЧЕСКОЕ ОБЕСПЕЧЕНИЕ ДИСЦИПЛИНЫ 

Основная литература 

1. Рег, Д. Промышленная электроника [Электронный ресурс] : учебник / Д. Рег. — 

Электрон. дан. — Москва : ДМК Пресс, 2011. — 1136 с. — Режим 

доступа:  https://e.lanbook.com/book/891 

2. Джеймс Рег Промышленная электроника [Электронный ресурс]/ Джеймс Рег— 

Электрон. текстовые данные.— Саратов: Профобразование, 2017.— 1136 c.— 

Режим доступа: http://www.iprbookshop.ru/63583.html — ЭБС «IPRbooks» 

https://e.lanbook.com/book/891
http://www.iprbookshop.ru/63583.html


3. Б. И. Коновалов, Ю. М. Лебедев. Теория автоматического управления: учебное 

пособие для вузов / Санкт-Петербург: Лань, 2010. – 219с. 

http://lib.dvfu.ru:8080/lib/item?id=chamo:307461&theme=FEFU 

4. Растворова И.И. Электроника и наноэлектроника [Электронный ресурс]: учебное 

пособие/ Растворова И.И., Терехов В.Г.— Электрон. текстовые данные.— СПб.: 

Санкт-Петербургский горный университет, 2016.— 205 c.— Режим 

доступа: http://www.iprbookshop.ru/71712.html — ЭБС «IPRbooks» 

5. Трушин В.Н., Андреев П.В., Фаддеев М.А. Рентгеновский фазовый анализ 

поликристаллических материалов. Электронное учебно-методическое пособие. - 

Нижний Новгород: Нижегородский госуниверситет, 2012. - 89 

с. http://window.edu.ru/resource/210/79  

 

Дополнительная литература 

1. Мордасов Д.М. Промышленная интеллектуальная собственность и патентование 

материалов и технологий [Электронный ресурс]: учебное пособие/ Мордасов Д.М., 

Мордасов М.М.— Электрон. текстовые данные.— Тамбов: Тамбовский 

государственный технический университет, ЭБС АСВ, 2014.— 128 c.— Режим 

доступа: http://www.iprbookshop.ru/63898.html — ЭБС «IPRbooks» 

2. Немцов М.В. Электротехника и электроника : учебник для вузов по направлениям 

подготовки и специальностям в области техники и технологии/ Москва : КноРус, 

2012. – 560 с.— Режим 

доступа: http://lib.dvfu.ru:8080/lib/item?id=chamo:837906&theme=FEFU  

3. Легостаев Н.С. Материалы электронной техники [Электронный ресурс]: учебное 

пособие/ Легостаев Н.С.— Электрон. текстовые данные.— Томск: Томский 

государственный университет систем управления и радиоэлектроники, 2014.— 

239 c.— Режим доступа: http://www.iprbookshop.ru/72057.html — ЭБС «IPRbooks» 

4. Легостаев Н.С. Микроэлектроника [Электронный ресурс]: учебное пособие/ 

Легостаев Н.С., Четвергов К.В.— Электрон. текстовые данные.— Томск: Томский 

государственный университет систем управления и радиоэлектроники, Эль 

http://lib.dvfu.ru:8080/lib/item?id=chamo:307461&theme=FEFU
http://www.iprbookshop.ru/71712.html
http://window.edu.ru/resource/210/79
http://www.iprbookshop.ru/63898.html
http://lib.dvfu.ru:8080/search/query?match_1=PHRASE&field_1=a&term_1=%D0%9D%D0%B5%D0%BC%D1%86%D0%BE%D0%B2,+%D0%9C%D0%B8%D1%85%D0%B0%D0%B8%D0%BB+%D0%92%D0%B0%D1%81%D0%B8%D0%BB%D1%8C%D0%B5%D0%B2%D0%B8%D1%87.+&theme=FEFU
http://lib.dvfu.ru:8080/lib/item?id=chamo:837906&theme=FEFU
http://www.iprbookshop.ru/72057.html


Контент, 2013.— 172 c.— Режим доступа: http://www.iprbookshop.ru/72131.html — 

ЭБС «IPRbooks» 

5. Коновалов Б.И. Электропитание ЭВМ [Электронный ресурс]: учебное пособие/ 

Коновалов Б.И.— Электрон. текстовые данные.— Томск: Томский 

государственный университет систем управления и радиоэлектроники, 2015.— 

177 c.— Режим доступа: http://www.iprbookshop.ru/72230.html — ЭБС «IPRbooks» 

 

Нормативно-правовые документы 

1. ГОСТ Р 57700.6-2017 Численное моделирование физических процессов. 

Термины и определения в области бессеточных методов численного 

моделирования. 

2. ГОСТ 19693-74 Межгосударственный стандарт. Материалы магнитные. 

Термины и определения. 

3. ГОСТ 15971-90. Системы обработки информации. Термины и определения 

4. ГОСТ 8.417-02. ГСИ. Единицы величин. 

5. ГОСТ Р 8.563-96. Государственная система обеспечения единства измерений. 

Методики выполнения измерений. 

 

Перечень информационных технологий и программного обеспечения 

При осуществлении образовательного процесса по дисциплине может 

использоваться стандартное программное обеспечение компьютерных учебных 

классов (Windows, Microsoft Office). Также необходим программный пакет 

LabView для выполнения программ, созданных на графическом языке 

программирования «G» фирмы National Instruments. 

 

VI. МЕТОДИЧЕСКИЕ УКАЗАНИЯ 
ПО ОСВОЕНИЮ ДИСЦИПЛИНЫ 

В общей трудоемкости дисциплины 108 часов (3 ЗЕ); аудиторные 

лекционные занятия составляют 10 часов, практические – 26 часов. По 

дисциплине предусмотрена внеаудиторная самостоятельная работа в объеме 72 

http://www.iprbookshop.ru/72131.html
http://www.iprbookshop.ru/72230.html


часа на весь курс дисциплины.  

В процессе обучения студент должен не только освоить учебную программу, 

но и приобрести навыки самостоятельной работы. Студент должен уметь 

планировать и выполнять свою работу. Удельный вес самостоятельной работы 

обычно составляет по времени 35% от всего времени изучаемого цикла. Это 

отражено в учебных планах и графиках учебного процесса, с которыми каждый 

студент может ознакомиться у преподавателя дисциплины или на кафедре. 

Главное в период обучения своей специальности – это научиться методам 

самостоятельного умственного труда, сознательно развивать свои творческие 

способности и овладевать навыками творческой работы. Для этого необходимо 

строго соблюдать дисциплину учебы и поведения. 

Каждому студенту следует составлять еженедельный и семестровый планы 

работы, а также план на каждый рабочий день. С вечера всегда надо распределять 

работу на следующий день. В конце каждого дня целесообразно подводить итог 

работы: тщательно проверить, все ли выполнено по намеченному плану, не было 

ли каких-либо отступлений, а если были, по какой причине это произошло. 

Нужно осуществлять самоконтроль, который является необходимым условием 

как успешной учебы, так и последующей работы. Если что-то осталось 

невыполненным, необходимо изыскать время для завершения этой части работы, 

не уменьшая объема недельного плана. 

Организация деятельности студента. 

Практическая работа. Перед выполнением практических работ студенты 

должны ознакомиться с теоретическим материалом по текущей теме. Если при 

изучении данного материала возникли вопросы, проконсультироваться с 

преподавателем. Прочитать инструкцию по выполнению практической работы. 

Составить план выполнения для достижения поставленных задач.  В случае 

затруднений необходимо обратиться к преподавателю. Следуя составленному 

плану, начать выполнение практической работы. После выполнения каждого 

этапа, необходимо сделать анализ полученных результатов. Если результат 

удовлетворяет всем требованиям, указанным в задании, перейти к следующему 



этапу. В противном случае, если результат не удовлетворяет требованиям 

задания, приводит к некорректным выводам и/или ответам, необходимо 

проанализировать причины, приведшие к ошибкам. Работа над ошибками 

является одним из условий процесса совершенствования знаний и навыков а, 

следовательно, успешной учебы и работы.  

После выполнения всех этапов практической работы нужно составить отчет 

о проделанной работе. Представить данный отчет на проверку преподавателю. 

Самостоятельная работа. Выполнение самостоятельной работы 

студентами необходимо для успешного закрепления изученного материала и 

навыков моделирования, приобретенных на практических работах. Процесс 

выполнения схож с практическими работами, с одним отличием – отсутствует 

возможность текущей консультации с преподавателем по возникающим ошибкам, 

либо трудностям. Благодаря этому студент начинает приобретать навыки 

самостоятельного анализа и решения проблем, что позволяет лучше усвоить 

материал. Перед выполнением самостоятельной работы прочитать поставленное 

задание и составить план действий для его выполнения. Следуя составленному 

плану, начать выполнение самостоятельной работы. Анализ полученных 

результатов, необходим после выполнения каждого этапа. Если результат 

удовлетворяет всем требованиям, указанным в задании, перейти к следующему 

этапу. После выполнения всех этапов самостоятельной работы нужно оформить 

результаты в виде отчета. Представить данный отчет на проверку преподавателю 

на практическом занятии. 

 

VII. МАТЕРИАЛЬНО-ТЕХНИЧЕСКОЕ ОБЕСПЕЧЕНИЕ 

ДИСЦИПЛИНЫ 

Практические занятия проводятся в компьютерных классах лабораторного 

корпуса (корпус L). На компьютерах должен быть установлен программный пакет 

LabView для выполнения практических заданий. Для обработки результатов 

моделирования и анализа результатов можно использовать стандартные 

программы для построения графиков в операционной системе Windows. 



Наименование 
специальных 
помещений и 
помещений для 
самостоятельной 
работы 

Оснащенность специальных помещений и 
помещений для самостоятельной работы 

Перечень лицензионного 
программного 
обеспечения.  
Реквизиты 
подтверждающего 
документа 

690922, Приморский 
край, г. Владивосток, 
остров Русский, 
полуостров Саперный, 
поселок Аякс, 10, корпус 
L, ауд. L551 

Компьютерный класс. Учебная аудитория для 
проведения занятий лекционного типа, занятий 
семинарского типа, групповых и 
индивидуальных консультаций, текущего 
контроля и промежуточной аттестации. 
Количество персональных компьютеров для 
организации учебного процесса -10 
Количество посадочных рабочих мест для 
студентов - 30 

Microsoft 
Office365/Microosoft/США/
Платное ПО 
Microsoft 
Teams/Microosoft/США/Пла
тное ПО 
Blender/ Blender 
Foundation/Нидерланды/Бес
платное ПО 
PyCharm/JetBrains/Прага
 /Бесплатное ПО 

 
УЧЕБНО-МЕТОДИЧЕСКОЕ ОБЕСПЕЧЕНИЕ САМОСТОЯТЕЛЬНОЙ 

РАБОТЫ ОБУЧАЮЩИХСЯ 
 

План-график выполнения самостоятельной работы по дисциплине 
 

№ 
п/п 

Дата/сроки 
выполнения 

Вид самостоятельной работы Примерные 
нормы 
времени на 
выполнение 

Форма 
контроля 

1 1-2 недели  Подготовка к практической работе №1 8 час. Работа на 
занятии 

2 3-4 недели Подготовка к практической работе №2 8 час. Работа на 
занятии  

3 5-6 недели Подготовка к практической работе №3 8 час. Работа на 
занятии 

4 7-8 недели Подготовка к практической работе №4. 
Выполнение самостоятельного задания 
по теме 1 

8 час. Работа на 
занятии 

5 9-10 недели Подготовка к практической работе №5 8 час. Работа на 
занятии 

6 11-12 недели Выполнение самостоятельного задания 
по теме 2 

8 час. Проверка 
домашней 
работы 

7 13-14 недели Подготовка к практической работе №6 8 час. Работа на 
занятии  

8 15-16 недели Выполнение самостоятельного задания 
по теме 3 

8 час. Проверка 
домашней 
работы 

9 17-18 недели Подготовка к практической работе №7 8 час. Работа на 
занятии 

Итого 72 час.  



Характеристика заданий для самостоятельной работы обучающихся и 
методические рекомендации по их выполнению 

Задания и методические рекомендации для самостоятельной работы 

обеспечивают подготовку практическим занятиям, а также закрепление материала 

по пройденным темам. Их полное содержание приведено в программе и 

методических указаниях. Методические указания к практическим занятиям в 

электронном виде и печатном виде берутся у ведущего преподавателя. 

Требования к представлению и оформлению результатов самостоятельной работы 

Результаты самостоятельной работы отражаются в кратких отчетах, где 

приводятся результаты каждого из практических занятий и заданий для 

самостоятельной работы. Отчеты по практическим занятиям и самостоятельной 

работе предоставляются преподавателю в электронном виде (где необходимо, 

компьютерное моделирование и построение графиков с помощью 

вычислительных средств) или письменном виде (если занятие проводится без 

использования компьютеров). 

К представлению материалов по результатам практических занятий 

предъявляются следующие требования. 

Структура краткого отчета по результатам практического занятия и 

самостоятельной работы. 

Если для данного занятия необходимо предоставить материалы в 

электронной форме, то они подготавливаются как текстовые документы в 

редакторе MS Word. 

Краткий отчет по результатам практического занятия, либо 

самостоятельной работы должен быть обобщающим документом, включать всю 

информацию по выполнению заданий, в том числе исходный код моделируемой 

задачи, построенные графики, расчеты, необходимые пояснения и иллюстрации 

микромагнитной структуры и т.д. 

Структурно краткий отчет по результатам практического занятия, либо 

самостоятельной работы состоит из следующих частей: 



 Исходные данные к выполнению заданий – обязательная компонента 

отчета, начинается с новой страницы, содержат указание варианта, тему, план 

работы и т.д.); 

 Основная часть – материалы выполнения заданий, разбивается по 

рубрикам, соответствующих заданиям работы, с иерархической структурой: 

разделы – подразделы – пункты – подпункты и т.д.  

 Выводы – обязательная компонента отчета, содержит обобщающие 

выводы по работе (какие задачи решены, оценка результатов, что освоено при 

выполнении работы); 

Краткий отчет по результатам практического занятия и самостоятельной 

работы оформляется по правилам оформления письменных работ студентами 

ДВФУ. 

Необходимо обратить внимание на следующие аспекты в оформлении 

кратких отчетов: 

• набор текста (если необходим отчет в электронной форме);  

• структурирование работы; 

• оформление заголовков всех видов (рубрик-подрубрик-пунктов-

подпунктов, рисунков, таблиц, приложений); 

• оформление перечислений (списков с нумерацией или маркировкой); 

• оформление таблиц; 

• оформление иллюстраций (графики, рисунки, фотографии, схемы, 

«скриншоты»);  

• набор и оформление математических выражений (формул); 

Если набор текста осуществляется на компьютере, то необходимо 

придерживаться следующих требований: 

 печать – на одной стороне листа белой бумаги формата А4 (размер 210 на 

297 мм.); 

 интервал межстрочный – полуторный; 

 шрифт – Times New Roman; 



 размер шрифта – 14 пт., в том числе в заголовках (в таблицах допускается 

10-12 пт.); 

 выравнивание текста – «по ширине»; 

 поля страницы – левое – 30 мм, правое – 10 мм, верхнее и нижнее – 20 мм; 

 нумерация страниц – в правом нижнем углу страницы (для страниц с 

книжной ориентацией), сквозная, от титульного листа до последней страницы, 

арабскими цифрами;  

 режим автоматического переноса слов, за исключением заголовков всех 

уровней (перенос слов для отдельного абзаца блокируется средствами MSWord с 

помощью команды «Формат» – абзац при выборе опции «запретить 

автоматический перенос слов»). 

Графическая информация: изображения микромагнитной структуры, 

графики, диаграммы моделей, схемы, экранные формы и т.п., должны отвечать 

требованиям визуальной наглядности представления иллюстративного материала 

как по размерам графических объектов, так и разрешающей способности 

отображения текстов, цветовому оформлению и другим важным 

пользовательским параметрам. 

Рекомендуется в среде программного приложения mmDisp OOMMF 

настроить параметры масштабирования и цветовой схемы для наглядного 

отображения микромагнитной структуры. 

Приведенные в отчет изображения рекомендуется отмасштабировать для 

заполнения страницы отчета «по ширине». 

Изображения и графики в кратком отчете оформляются как рисунки, с 

заголовками, помещаемыми ниже области рисунков. 

Критерии оценки выполнения самостоятельной работы 

Оценивание результатов практических занятий и самостоятельных работ 

проводится по критериям: 

- полнота и качество выполненных заданий; 



- владение методами и приемами микромагнитного моделирования в 

исследуемых вопросах, применение специализированных программных средств 

(если необходимо); 
- отсутствие фактических ошибок, связанных с пониманием проблемы или задачи; 

- отсутствие значительных ошибок в приводимых количественных 

результатах. 
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